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INTRODUCTION 
 

 
Welcome to NuVJ!  NuVJ is an intuitive VJ environment which seamlessly integrates software and hardware for 
a professional quality, hassle-free performance.  The NuVJ environment is based around a DJ-style setup which 
allows you to mix, scratch, and apply effects to video clips and images.  We have designed the NuVJ software 
and controller to be simple to use, while allowing for unprecedented variation and creativity with your visual 
sources.  And with an extended set of features such as live inputs, synchronization to music, and real-time 
visual effect generation, we hope that you enjoy using this product as much as we enjoyed building it for you! 
 
Sincerely, 
 
The People of Numark and Arkaos 
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CONTROLLER OVERVIEW 
 

 
The NuVJ controller provides a simple and quick way to interface with the most important functions and 
features of the NuVJ software.  The controller was specifically designed to control the NuVJ software, but may 
also be used as a generic MIDI controller for a variety of other software applications and hardware devices 
which support the MIDI protocol.   
 

Please note:  The NuVJ controller was specifically designed to be used with the NuVJ software.  
However, it may also used as a generic MIDI controller for various other applications which respond 
to MIDI commands.  If  you use the NuVJ controller with another software application, you might 
notice that some of the controller features are disabled.  For example, the pads and buttons will 
not light up.  This is normal and the controller will still function properly.   

 
For the purposes of this manual, we will only explain the control surface functionality when used in conjunction 
with the NuVJ software.  Please also read the “Introduction to the Software” and “Using the Software” sections 
of this manual for more information on the software. 
   

Top Panel  
 

 

 
 

1. PADS: The 9 pads on each side control which ‘clip’ is displayed on each ‘deck zone’. Taping 
the pad will trigger the clip that is assigned to the particular ‘cell’ in the software.  Please see 
Introduction to the Software section for infromation on clips, cells, and decks. 

2. WHEEL: The wheels on each side can be used to scratch or speed up/slow down the video 
currently playing.  If you hold down the [SCRATCH] button underneath the wheel, you can 
use the wheel for scratching the video content.  If the button is not held down, you can use 
the wheel to speed up and slow down clips temporarily, like a pitch bend. 

3. SPEED: The two vertical sliders in the middle set the speed of the video playback, allowing 
you to slow down, accelerate or reverse the video on each deck zone. 

4. [SCRATCH]: When this button is held down, the jog wheel can be used to scratch the video 
playing on that deck. 
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5. [INSTA A/B]: These buttons allow you to quickly switch the video output to one of the 
decks.  For example, if you press [INSTA A] the video output will only show what is playing 
on deck A, regardless of the crossfader position, until you release the [INSTA A] button.  The 
speed of the fade when the [INSTA A/B] buttons are pressed is determined by the Auto Fade 
Speed knob on the front panel. 

6. BANK: Use this knob to select different banks of video clips.  Each bank contains up to 9 
clips which can be toggled by pressing the corresponding pad.  There are 16 different banks 
which can be used on either of the two deck zones. 

7. PMTR1: Each cell in a bank can be assigned an effect through the software. The PMTR1 knob 
will then adjust the first effect parameter of the cell currently playing on that bank.  This 
parameter will be different, depending on which effect you have chosen for the particular cell. 

8. PMTR2: The PMTR2 knob adjusts the second effect parameter of the cell currently playing on 
that bank.  This parameter will be different, depending on which effect you have chosen for 
the particular cell. 

9. [LATCH]: If the [LATCH] button is pressed on, the clips on the deck will play continuously 
when triggered.  If the [LATCH] button is pressed off, then the clips on the deck will play for 
as long as the corresponding pad is held down. 

10. [AUTO]: Press this button to play the clips (cells) of the current bank in a random 
automated fashion. 

11. [SYNC]: Press this button to synchronize the playback of the video clips playing on the deck 
to the BPM of the session. 

12. DISPLAY: The display helps you keep track of software parameters. 

13. FX LEVEL: This knob adjusts the Master FX Mix.  This setting describes how much of the 
selected Master Effect will be mixed in with the original image.  As you turn up the FX Level 
knob, you will see more of the effected mix.  As you turn down the FX Level knob, you will 
see more of the original image. 

14. [MASTER FX]: Press this button to activate and deactivate the Master Effect.  You can swap 
effects on the fly by selecting the desired effect with the Master FX knob.    

15. MASTER FX: Rotate this knob to select the Master Effect.  The Master effect will be applied 
to the master mixing zone.   

16. PMTR1: This knob adjusts the first parameter of the Master Effect.  This parameter will be 
different, depending on which effect you have chosen. 

17. [INSTA BLACK]: Pressing this button will toggle the video output to black or to a selected 
background visual assigned in the NuVJ software.  

18. CONTRAST: Use this knob to adjust the contrast of the video output. 

19. PMTR2: This knob adjusts the second parameter of the master effect.  This parameter will 
be different, depending on which effect you have chosen. 

20. [BPM TAP]: You can use this button to manually adjust the tempo of the session by tapping 
the button to the beat.  If you hold the button for 3 seconds and then release it, the BPM of 
the session will go back to the BPM detected from the sound input. 

21. BRIGHT: Use this knob to adjust the brightness of the video output. 

22. CROSSFADER: The crossfader allows you to mix the two visuals playing on each side.  If you 
move the crossfader to the right, you will see more of the right visual.  Conversely, if you 
move the crossfader to the left, you will see more of the left visual blended in. 
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Rear Panel 
 

 

 

 

1. AC IN: If the unit is not being powered by the USB connection, it can be powered by 
plugging an 6V-1A DC power adapter into this input. 

2. POWER: Press this button if you wish to power the unit using an AC adapter.  Otherwise, 
when plugged in using the USB connection, the unit will be powered from the computer’s USB 
bus.  

3. USB: Connect a USB cable from your computer into this input.  This port is used to power 
the unit, as well as to transmit MIDI control to your computer and the software.  You may 
also power the controller alternatively by plugging in a 9v1a AC power adapter. 

4. KENSINGTON LOCK: The unit can be attached and secured to a surface using this 
Kensington Lock slot. 

   

Front Panel 
 

 

 
 
1. FADER MODE: This switch determines the operation of the Fader Start option, as specified in 

the software. 

2. AUTO FADE SPEED: This switch adjusts the speed of the auto fade. The auto fade speed 
determines the speed of the fade from the current position to full A/full B when using the 
Insta A/B buttons on the top panel. 

3. FADER START: Fader Start allows you to start a selected pad by moving the fader toward 
the deck that it is loaded on.  For example, if the crossfader is in an extreme left or right 
position, moving it toward the opposite side will trigger the video selected on that deck.   
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CONNECTING THE CONTROLLER TO YOUR COMPUTER 
 

 

 
 

To connect the NuVJ to your computer, please connect the supplied USB power cord from the USB 
port on the NuVJ to an an available USB port on your computer.  There is no need to plug in an 
adapter – your computer’s USB bus will power the controller – but if you would like to use external 
power, you may do so by plugging in a 6v1a adapter.   

The NuVJ is a Plug and Play device so there are no drivers or special software to install.  When you 
plug in the controller, you will see the screen illuminate and display “NuVJ”.  

 
Please note: When using the NuVJ control surface with other software, some of the 
features of the control surface will be disabled.  These features include the LED lights, 
as well as the value readout on the display.  The display will simply say “NuVJ”. 
 
Please also note:  If you have installed Logitech Quickcam drivers, your computer will 
not be able to properly recognize many MIDI devices, including the NuVJ.  To use the 
controller, you will need to uninstall the Logitech Quickcam driver.  The controller will 
then be able to function properly.  To uninstall the driver, you need to right-click on My 
Computer, then Properties -> Hardware -> Device Manager.  This allows you to see all 
the devices installed on your machine.  Find the Logitech Quickcam device, right-click it 
and select “Uninstall”.  This will uninstall the device and its driver. 
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INSTALLING THE SOFTWARE - PC 
 

 
 

1. To install the NuVJ software, please insert the NuVJ installation CD into your computer’s CD-ROM 
drive. 

2. Double-click on the NuVJ installation file, located in the root directory on the CD.  This will launch 
the InstallShield Wizard. 

3. Follow the on-screen instructions.   
Please note:  The installation program will scan your available video components prior to installing 
the software.  If there are any components which are not up to date, please install them by clicking 
on their corresponding button before proceeding with the installation. 

4. Once the installation is complete, click “Finish”.  The NuVJ software is now ready to be used. 
5. Ensure that the controller is connected to your computer’s USB port and start NuVJ by going to 

Start -> Arkaos NuVJ -> Arkaos NuVJ. 
Please note:  If the controller is connected after the NuVJ software has been launched, it may not 
function.  You will need to restart the software.  In general, please always connect the controller 
before starting the software. 

6. Enter the serial number (16 characters) that came with NuVJ. 
7. Once the correct serial number has been entered, you may wish to register your copy of NuVJ.  You 

need to be connected to the Internet to register NuVJ.  Registering will allow you to access 
additional online content and program updates. 

 
 

 

INSTALLING THE SOFTWARE - MAC 
 

 
 

1. To install the NuVJ software, please insert the NuVJ installation CD into your computer’s CD-ROM 
drive. 

2. Click on the NuVJ installer located on the CD. 
3. Follow the on-screen instructions. 
4. Once installation is complete, you will see a shortcut on the desktop.  The application will also 

appear in your Applications -> NuVJ folder. 
5. Ensure that the controller is connected to your computer’s USB port and launch NuVJ. 

Please note:  If the controller is connected after the NuVJ software has been launched, it may not 
function.  You will need to restart the software.  In general, please always connect the controller 
before starting the software. 

6. Enter the serial number (16 characters) that came with NuVJ. 
7. Once the correct serial number has been entered, you may wish to register your copy of NuVJ.  You 

need to be connected to the Internet to register NuVJ.  Registering will allow you to access 
additional online content and program updates. 
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INTRODUCTION TO THE SOFTWARE 
 

 
In this section, we will take a quick tour of the software and explain some key concepts to its operation.  We 
highly recommend reading this section – it will give you a good overview of NuVJ’s functionality, as well as 
teach you some fundamental concepts of video mixing. 
 

Basics 
 

 
NuVJ allows you to mix videos and images in real time in a very intuitive way. It is built around a 
DJ-deck like setup where you have two playback decks and can mix the output of the decks using a 
mixing slider. 

 

              

 Movie A Movie B 

Video 
Mixer 

Output 

 
 
 

This setup is reflected both in the software interface and on the controller: deck A is represented 
by the left area of the main panel, while deck B by the right side and the mixer and master effect 
controls are in the middle, as shown in the following graphic: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
On each deck zone, you can see a series of squares.  These are called ‘cells’ and are placeholder 
for video clips, images or flash files (we’ll globally refer to them as ‘clips’.  Each deck can play one 
cell at the time. 

 
To assign a clip to a cell, simply drag and drop any image or video from the file browser located on 
the left most side of the interface or directly from the explorer/finder window. Once assigned, you 
can then click on the cell to trigger it or, alternatively, press the corresponding pad on the NuVJ 
controller.  By starting a cell in each deck, you can see each of them playing in their respective 
preview window and see the result of the mixing in the central window.  Move the mixing slider 
either using the mouse or the crossfader on the controller to see the mixing balance change in the 
preview window.   
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The big picture 
When doing a performance, you usually need to project the output in full 
resolution.  To do so, you will need to activate the full screen mode in the 
software interface.  This is done by clicking on Display > Toggle 
Fullscreen or, alternatively, by pressing CTRL+A (Command+A on Mac) on 
the computer keyboard.  To exit full screen mode, press CTRL+A again. As 
we will see later on (see Preferences/Display further in this document), if 
your video card allows multiple video outputs, you can have the interface 
displayed on your main monitor while the full screen output result is sent to 
the secondary monitor output to which you can attach a projection device. 
 

 
 

Overview 
 

 
As we’ve just seen, NuVJ runs around a simple A/B deck & mixing set-up.  In this chapter, we’ll 
explore more of its features in detail. 
 

Decks:  

As said previously, decks are sources for video streams. 
They contain cells that are placeholders for clips. When 
you trigger a cell in a deck, you can see the preview of 
the movie/image running in the preview window located 
on the top of the deck area. Only one cell at a time can 
play in a deck. The cell currently running on the deck is 
highlighted in red on the software interface and a LED is 
also providing feedback on the control surface. 

Cells:  
 
Cells are placeholders to which you assign the clips you 
intend to use in your mix.  In addition to containing a clip, 
cells can also be assigned an effect which will then 
automatically be applied to the clip loaded in that 
particular cell.  To assign an effect to a cell, simply drag 
and drop an effect from the Effects browser list on the left 
onto the desired cell.  If a cell with an effect has been 
triggered, two knobs on top of the cell area become active 
and allow you to modify the effect parameters.  Effect 
parameters can be changed either using the mouse on the 
interface or with the two effect parameter knobs (PMTR1 
and PMTR2) on each deck side of the controller.  For 
example, on the figure on the right, a directional blur has 
been set on the top left cell, and its two parameters, 
LEVEL and DIRECTION, are available for tweaking.  When 
a cell is selected (right-click) or played (left-click) with the 
mouse, a panel with advanced cell parameters is updated 
on the lower side of the screen.  It allows modifying 
playback and mixing parameters, as well as the default 
parameters for the effect when the cell is triggered. For 
special ‘text files’, the text to be displayed can also be 
edited there.  Cell parameters will be explained in more 
detail further in this manual. 

 

Files:  
 
Files are source material to be played in cells.  You can either 
drag and drop files directly from an explorer/finder window or 
use NuVJ’s integrated file browser on the left of the interface.  
NuVJ supports a number of video, image and flash file formats. 
See the Performance Tips section at the end of the manual for a 
discussion of the various fille formats and their efficiency.  In 
addition to playing individual files, you can also drag and drop a folder to a cell – NuVJ will play all videos 
and images located in that folder, one after the other in a slide show fashion.  
 

Please note:  for memory reasons, the files played when using a folder are not pre-cached 
and switching from one visual to another is less effective when played through a folder than 
when triggered directly. 

                                   DECK 

 

 

 

 

 

 

 

 

   CELL 
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Effects:  
 
Effects are used to alter clips in various ways. NuVJ provides a 
wide collection of effects sorted in different categories. They are 
listed in the second tab of the browser section on the leftmost 
side of the interface. Effects can either be applied on cells to 
alter individual clips or on the master output to alter the result 
of the mixing. Note that depending on the capacity of your 
video hardware, not all effects might be available as some 
require high end video hardware to work. 
 
 
 
Sources:  
 
Sources are like clips except they are not related to files on the 
hard drive.  The sources are listed in the third tab of the 
browser section on the leftmost side of the interface.  Sources 
are divided in three main categories: live inputs, generators, 
and texts.  Live inputs collect all available camera inputs on the 
system.  Using these, you can feed NuVJ directly with USB or 
Firewire web cams, DV cams, acquisition boards, and other 
video devices. The Inputs category shows all live inputs 
recognized by the system. Generators are elements that 
automatically generate patterns using internal effects processing and the signal from the audio input, much 
like the visualization modules from iTunes or Windows Media Player.  To assign a source to a cell, simply 
drag and drop it onto the desired cell. The third categorie, ‘texts’ contain special files that can be used to 
dispay text for presentation, announcement and so on. 

 
 

USING AUDIO INPUT:   
 

NuVJ allows you to synchronize your video clips and performance to signal from your audio input.  To 
make use of this feature, please connect an audio source to the line-level input on your computer’s 
soundcard.  You will need to make sure that the line input is selected as an input source.   

PC: Please go to My Computer -> Control Panel -> Sounds and Audio Device Properties, click on the 
Audio tab and then click on Advanced – this will pull up the Volume Control panel.  Click on Options -
> Properties -> Recording – this allows you to view the recording input sources.  Please make sure 
that Line In is checked and that the volume slider is up. 

To be able to hear the audio input through your computer’s soundcard, you will need to go back to 
Options -> Properties -> Playback and make sure that Line In is not muted and that the volume slider 
is up.  

On some soundcards, you can select the output of the card as recording device. It is generally found 
in the recording sources as ‘Stereo mix’.  If your card has such a channel, selecting it will allow you to 
directly synchronize NuVJ to the audio playing on the same PC. 

MAC: Please go to Finder -> Applications -> System Preferences, and click on the Sound icon.  Select 
Input to view the available input sources.  Select the device that you would like to use as the input 
device – once this device is selected, NuVJ will synchronize its session BPM to this device. 

 
The visual library:  
 
The visual library is a convenient way to find clips that are 
already loaded in the application. Once a clip is loaded in NuVJ, 
it will become available in the visual library and can be accessed 
at any time during your session.  The library is located on the 
fourth tab of the browser section. You can directly drag and drop 
visuals from the library onto the cells without having to search 
for them again on your hard drive. 

 

Banks:  
 
Banks are collections of nine cells.  There is always 
one bank selected on each deck.  The current bank 
number is displayed in the blue area just 
underneath the deck preview window.  You can 
change banks at any time by pressing the up and 
down arrows, or by rotating the BANK knob on the 
controller.  Using banks, you can organize your 
clips according to themes, mood, or type of 
sequences. 
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Deck Playback control:  
 
Next to the bank selection display, there are a few controls which can be used to alter the playback of the 
cells on that deck: 

 
The top indicator is the playback position inside the current clip. 
 
The bottom indicator controls the speed at which the clip is playing.  The center represents a speed of 
zero (the clip will be frozen).  If the indicator is located in the right side region, the movie will be 
played forward while if on the left side region, the movie will be playing backward.  The further you 
get from the center, the faster the movie will play.  To modify the speed of playback using the 
interface, simply click inside the control to move the speed indicator to that point.  You can also 
adjust the speed of playback using the SPEED sliders on the controller. A vertical bar in the speed 
indicator shows the speed point where the movie is playing at nominal speed. When the speed is set 
around the nominal speed, the speed indicator will turn red 
 
 
 
 
 
 
 
 
The [LATCH] button influences how cell triggering reacts.  If it is activated, the cell will keep on 
playing after you release the mouse or the pad on the control surface.  If it is deactivated, the cell will 
stop playing as soon as you release the mouse/controller pad.  You can also activate/deactivate the 
mode using the LATCH button on the control surface. 
 
The [SYNC] button engages a ‘synchronized playback’ mode for the clips.  When activated, NuVJ 
adapts the movie speed to be ‘in sync’ with the BPM detected from the audio input.  You can toggle 
the sync mode from the controller using the dedicated button. When sync is engaged, movie speed 
can still be altered by the speed sliders. 
 
The [AUTO] button engages the automated mode for the deck.  In automated mode, NuVJ will 
automatically trigger cells from the current bank in a random fashion, following the BPM detected 
from the audio input.  This can be useful if you need a rest in the middle of a performance or simply 
want to automatically blend visuals together. 

 
 
The Crossfader:  
 
The crossfader is located in a central position. Using either 
the mouse or the slider on the controller, you can use the 
crossfader to blend your movies together.  If the fader is on 
the far left side, only the output of deck A will be visible, 
while if on the far right side, only the output of deck B will be 
shown.  In intermediate position, both A & B will be blended according to a ‘transition’ curve that can be 
chosen.  To select the transition curve, right-click the crossfader and select one of the available transitions.  
The controller also features a FADER MODE switch on the front panel that allows selecting among 3 pre-
defined transition curves.  For more information on defining the transitions used by the control surface, see 
further in the Preferences section. 
 
The Master Effect:  
 
The master effect is an additional effect that can be applied to the 
output of the image mix.  The master effect can be selected either 
from the software interface or from the MASTER FX knob on the 
control surface.  Each effect allows up to two parameters to be 
tweaked with the PMTR1 and PMTR2 knobs on the control surface. 
The FX LEVEL (Master FX Mix) knob allows setting the percentage 
of the effected image that will go in the final output.  You can also 
completely bypass the master effect by pressing the MASTER FX 
button on the controller. 

 
 
Brightness/Contrast control:  
 
Before the image is sent to the main output, you can adjust 
its brightness and contrast. This allows you to adjust the 
image to the room’s lighting conditions or to compensate for 
a loss/gain of brightness due to heavy image processing and 
blending. The contrast and brightness settings can be 
controlled either from the user interface or directly from the control surface with the CONTRAST and BRIGHT 
knobs.  If you don’t use this feature, you can bypass it in the Preference dialog – this will save some CPU 
power and could slightly improve performance. 

 

Please note that the efficiency of playback at non-nominal speed 
depends a lot on the type of movie and compression used for the clips.  
See Performance Tips section of this manual for more information on 
this topic. 
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Advanced Features 
 

 
Background:  
 
NuVJ allows the possibility to put a background clip that will be displayed if no clip is played on neither of 
the two decks or if the [INSTA BLACK] button on the controller is pressed. The background clip is defined in 
the Preferences dialog by going to File > Preferences, and can also be replaced ‘on the fly’ by drag and 
dropping a clip on the master preview window. In the Preferences menu you can also activate the usage of 
copy & blending modes (see further) between deck A and the background.  This option is not activated by 
default to avoid any confusion. 
 
Cell parameters and advanced mixing:  
 
When clicking on a cell with the mouse or triggering it with one of the pads, the cell parameter panel at the 
bottom of the interface is updated to show settings for the selected cell. To edit a cell’s parameters without 
triggering it, simply click on the cell using the right mouse button. The parameter panel contains advanced 
options that will allow you to take mixing and performances a step further.  To illustrate these options, we’ll 
imagine mixing the two following images: 

 
Deck A: 

 
 

 
Deck B: 

 

 
Copy modes:  
 
Copy modes express the way cells from deck A & B are blended together in the mixer.  Unless a special 
option is set (see Preferences / Advanced), theses settings will be effective only when a cell is running on 
deck B.  This is because deck B is virtually considered to be ‘on top’ of deck A and copy modes define the 
way B is ‘merged’ onto A. 

 
The copy mode defines the mathematical operation used 
to combine the pixel color from deck B with the pixel 
color from deck A. Let’s review them in order, from left to 
right. 
 

 
The default is the copy mode. In this mode, the cell on deck B will simply be mixed with the cell 
on deck A, that is to say that the resulting output will be some pixel averaging of each image. 

 
The addition mode is where pixels from B will be added to pixels of A.  If this mode is selected 
(as well as the subtraction, multiplication, maximum and minimum modes), the effect is maximal 
when the mixing slider is all the way on the right.  

 
 

The subtraction mode is where pixel colors from deck B are subtracted from deck A, resulting 
into an ‘inverse’ blending of B into A.  

 
 

         The multiplication mode is where pixels from deck B are multiplied with the pixels from deck A.  
 
 

The maximum mode selects pixels from either deck A or B, depending on which one has the 
strongest luminance. 

 
 

The minimum mode selects pixels from either deck A or B, depending on which one has the 
lowest luminance.  

 
 
 

Please Note:  Deck A is also considered to be on top of the background 
color or visual selected in NuVJ.  This means that you can use copy and 
masking options to have the background visual be shown through deck A. 



12 

Masking options:   
 
The masking options allow removing (masking) part on the clip content, based on either a color or 
brightness characteristic. This process is also known as color or luminance ‘keying’. As for the copy modes, 
the masking settings are only applied to cells when running on 
deck B, since deck B is on top of deck A. When luminance or 
chrominance keying are activated, two knobs underneath the 
selection become active. These knobs allow defining the 
characteristics (center and width) of a band reject filter that will 
be applied either on the brightness levels or hue of the clip’s 
image. Any luminance or color belonging in that zone will be 
made transparent and A will be seen through. 

 
The default and leftmost mode disables keying. In this case, the center and width knobs are disabled as 
well. 

 
Luminance keying allows making a range of brightness values transparent. For example, if you 
put the center parameter all the way to the maximum, you will make all bright values (white) 
transparent and see the content of deck A underneath. The center defines the range of gray 
levels to be discarded. 

 
 

Chrominance keying allows making a color range transparent. The center knob position defines 
what color will be rejected and the width will define how spread the range of color around the 
center value will be removed. I  

 
Playback options:  
 
The playback options affect the way the clip will be played. There are three modes: One Shot, Loop and 
Ping-Pong. 

 
In One Shot mode, the movie plays once when triggered and stops if it 
reaches the end. 

  
In Loop mode, the clip will continuously loop. This is the default mode. 

 
In Ping-Pong mode, the clip will loop alternatively playing forward, then backward, then forward again...  

 
Effect options:  
 
The effect options on the right side allow setting up the default 
values for the effect parameters. These values will be recalled 
automatically each time the cell is triggered. They can always be 
changed live using the deck effect parameters (see deck section) but 
the default values set here will come back each time the cell is re-
triggered. To ‘copy’ the current live settings to the default 
parameters for that cell (so that they are remembered next time you trigger the cell), press down on the 
controller’s BANK knob for the selected deck.   
 
Text settings: 
 
When using texts from the source browser, you can alter the text displayed by modifying it in the text input 
located in the cell parameter panel. 

 

Bank import/export:  
 
As well as being able to load and save the whole content of you performance by going to the file menu, you 
can also import and export single banks by holding down right-click over a cell and selecting the entry from 
a pop up menu (see more explanation in the user interface description). This feature makes it easy to load 
groups of pre-defined visuals during your performance. It allows you to save an unlimited number of pre-
configured sets of clips and effects and recall them without having to stop the performance at any time. 

 
Double monitoring:  
 
To do a proper VJ performance, it is more convenient to use video cards that support double monitors. That 
way, you can project the output of the mixer to your second monitor (linked to a projection system for 
example) and still access the user interface alongside the controller on the primary monitor. To set up 
double monitoring within NuVJ, you first need to make sure your system is configured to work with two 
independent screen outputs (and not using cloning where both adapter outlets output the same image). 
Once you have set up your system, start NuVJ and go to the Preferences dialog (File > Preferences).  In the 
Display section select which monitor you would like to use for the full screen output. Once that is done, you 
can enter full screen mode by going to Display > Toggle Fullscreen or by pressing CTRL+A (command+A on 
Mac).  You can also exit full screen mode by pressing CTRL+A (command+A on Mac). 
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USING THE SOFTWARE 
 

 
This section details the various elements of the user interface as well as the way to fully interact with the 
program: 
 
The user interface is split into 4 different areas: the menu/browser zone (top left), the mixing zone (top right), 
the information window (bottom left) and the cell parameters panel (bottom right).            
         

 
 

Menus 
 

 
Menus are organized as follows: 

 
File 
    New: Clears all data and starts with a blank performance 
    Open: Opens a performance (.nvj) file 
    Save: Saves the current performance 
    Save As...: Saves the current performance as a new file 

       Preferences: Brings up the preferences dialog 
Quit: Quits the application. Only works when full screen is not active, in order to 
prevent shutting down in the middle of a performance 

 
Edit 

     Cut Cell: Removes the current edited cell and copies its content to the clipboard 
     Copy Cell: Copies the current edited cell to the clipboard 

       Paste Cell: Copies the clipboard to the current edited cell 
       Clear Background: removes the current background clip 

   Purge Visuals: removes any unused clips from memory. 
  

Display 
     Toggle Fullscreen: switches from/to full screen mode 

 
Help 
   Getting Started: opens pdf of NuVJ Quickstart Guide 
   Reference Manual: opens pdf of the NuVJ Reference Manual 
   Release Notes: displays pdf containing current software version information and      
   additional information regarding the software release. 
   NuVJ Web Site: opens NuVJ web site in your internet browser 
   Register: allows you to register NuVJ on the internet 
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The Browser Zone 
 

 
The browser zone provides various tree views for picking content and effects needed to build your 
performance. The zone contains four tabs that access Files, Effects, Sources, and the Library.  To 
use any of these, simply drag and drop an element from the browser onto a cell. Additionally, you 
can also drag and drop elements to any of the preview windows: If you drag to one of the deck 
preview windows, the element will replace the visual or effect on the cell that is currently playing.  
If you drag an element to the master preview, it will set the background clip or the master effect. 
 
Under the browser zone, you can find a file filter box that lets you select which files are going to be 
visible in the file browser. The default is to show all compatible files (videos, pictures and flash 
files) but you may wish to change it to show only pictures, only movies, only flash files or display 
all files present on your hard drive. 
 
Under the filter there is also a trash icon. This icon can be used to remove visuals and effects from 
cells by simply drag and dropping the cell or the effect icon of the cell to the trash icon. 
 

The Mixing Zone 
 

 
The mixing zone contains all the information related to deck content and preview, as well as the 
mixing slider and master effect. The leftmost column is Deck A, the rightmost is Deck B and the 
center is the Mixing and Master Effect Zone. 
 
Deck Zones (A and B): 

 

Each deck contains the following elements from top to bottom: 
  

The Deck Preview: Shows the cell output from the deck. You can drag and drop 
elements from the browser directly to the Deck preview, which will replace the visual or 
effect on the cell currently playing. 

 
Deck Controls: Contain the elements which allow you to control bank selection, deck 
playback speed, and set latch, auto and sync modes. See ‘Deck Playback Control’ in the 
‘Introduction to the Software” section of this manual for more information about these 
controls. 

 
Deck Effect Parameters: Allows altering the effect parameters of the cell currently 
playing. Please note that these modifications are only temporary: as soon as a new cell 
is triggered, the effect parameter values are reset to the value defined in the cell’s 
parameter panel. If you wish to copy the current effect parameters to the cell’s default 
parameters so they are used next time you trigger the cell, simply press down on the 
[BANK] button of the deck. 

 
Cells: In the lower part of the Deck, you see the nine cells of the selected bank. Drag 
and drop any file, effect or source from the browser to a cell to alter its content. Cell 
will show a snapshot of the clip it has been assigned to as well as a few informative 
icons as follows: 

 
A cell in gray scale, surrounded by a red outline means the cell is 
currently playing in the Deck. A pencil icon in the top left corner 
means the cell is selected for edition and that its parameters are 
visible in the cell parameter panel. It also means it is the current 
target for any copy/paste operation. To select a cell, click the cell 
either with the left mouse button (in which case the cell will be 
triggered and selected for edition) or with the right mouse button 
(in which case the cell will be selected but not triggered). 

 
The icon on the lower right means the cell has an effect applied on it. The one on the 
left of it means the cell has non-default copying and masking modes. 

 
You can drag and drop visuals and effect between cells cell. To drag a clip from one cell 
to another, simply click in the image area and drag it to another cell. To drag an effect 
from one cell to the other, drag the effect icon from one cell to another. 
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If you right-click a cell and hold it for a little while, a pop-up 
menu will appear with the following entries: 

  
Clear Visual: Removes the visual from the cell 
Clear Effect: Removes the effect from the cell 
Reset Cell: Remove all settings, visual and effects from the cell 
Import Bank: Imports a whole bank from a .nvjb file replacing 
the bank to which the cell belong. 
Export Bank: Allows to export all the bank to which the cell belong in a .njvb file. 
Clear Bank: Clear the content of the bank. The clips are still kept in memory for further 
access (through the visual library browser). To free the space used by clips not 
selected in any banks, use the ‘Purge Visuals’ from the edit menu. 

 
 
Mixing and Master Effect Zone: 

 
The middle zone contains all the elements relative to master output and mixing processing. It 
contains, from top to bottom: 

 
Output Preview: The output preview duplicates the images sent to a second monitor when in full 
screen mode. You can drag and drop browser element to the output preview. If you drag a Clip, a 
Camera Source or Generator, that element will replace the background currently selected (see 
background in the Concept section). If you drag an effect, that effect will be used as current Master 
Effect. 

 
Brightness and Contrast: These two controls allow correcting the contrast and brightness of the 
image, either to adapt to the room lighting condition or to compensate the result of heavy 
effecting. 

 
Master Effect Section: The master effect section lets you apply an additional effect to the output of 
the mixer. The effect can be selected using the combo box and three knobs below allow altering 
the effect itself. The first one determines the wet/dry percentage between the original output and 
the effected one while the two other allow modifying the specific parameters of the selected effect. 

 
Crossfader: Controls the mixing between Deck A and 
Deck B. On the far left it will only let through Deck A 
in the output, while on the far right, only B will be 
displayed. The way the image is mixed from A to B 
depends on the transition used. Transitions can be 
selected by right-clicking on the crossfader or by 
using the configured switch on the control surface. 
Note that the number of transitions available 
depends on the capabilities of your hardware. 
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The Information Zone 
 

 
The information zone on the bottom left of the screen shows dynamic information based on the 
element on which the mouse is located. If you need to get information on a specific item, simple 
hover your mouse on top of it and read the information here. 
 

The Cell Parameter Panel 
 

 
The cell parameter panel allows editing the parameters related to the cell currently 
selected for edition. There is only one such cell at the time and it can be recognized 
through the following icon overlaid on top of the visual’s snapshot:   

 
As explained in detail in the ‘Concept’ section, the panel allows modifying the playback and mixing 
characteristics of each cell. It is also used to set up the default effect parameters values that will 
be restored each time the cell is re-triggered. 
 

The Preferences Dialog 
 

 
The preferences dialog sets various settings regulating the way the program works. The settings 
are sorted in four categories, each of them accessible through a tab in the dialog: 
 
 General: 
 

Background Visual: 
Specifies the file to be used 
as background clip. This file 
will be played/shown when 
no cell is playing on either 
deck or when the ‘Fade to 
Black’ button from the 
controller is pushed. Either 
enter the full path of the file 
or use the select button to 
open a file browser. This file 
is used as default 
background and will be 
restored when you start the 
application, load a 
performance file or reset the 
data using the File>New 
menu. You can override the value set here either by selecting the Edit>Clear Background 
menu or by drag and dropping a clip directly on the master preview window.  
 
Automation Beat Count: Selects the number of beats that the automation  
waits before triggering a new visual. See ‘Concepts/Deck Playback controls’ 
 
Slide Show Time: NuVJ allows you to drag and drop folders on a cell. In that case, all 
movies/images/flashes located in that folder (and recursively) will be played one after 
the other in a slide show fashion. The ‘slide show time’ parameter sets how much time 
images will be displayed (in seconds) before displaying to the next visual in the 
hierarchy. 
 
Transition 2 & Transition 3: The controller has a switch setting that allows choosing 
between 3 transitions on the fly. The first transition will always be the default transition 
(Exponential Transparency) but the two others are configurable. These two lists allow to 
select which transition you would like to see associated with settings ‘2’ & ‘3’ of the 
transition switch. 
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Display:  

 
The display tab defines the options related to the full screen mode of the application. 

  
Full Screen Monitor: 
Defines the monitor to be 
used by the full screen 
mode of the application. By 
choosing a different output 
than your main monitor, you 
will be able to send the mix 
to the alternate output while 
keeping the user interface 
still visible for tweaking & 
visual feedback on your 
default monitor. 
  
Resolution: Specifies the 
resolution used internally to 
process all graphics. The 
lower value you specify, the 
faster calculations will be (and hence a better frame rate) but the lower the image 
quality. Experiment with different settings to achieve a proper balance between image 
quality and frame rate. Usually 800x600 is fine for projection devices. 
 
Exclusive Mode: Forces Windows to work in Exclusive mode. In this mode, 
performances are slightly better but it has a big drawback: once in this mode, you can 
only use NuVJ. Activating any other program will force NuVJ to exit full screen mode. 
This mode is therefore not recommended if you intend to run other applications while 
using the NuVJ. 

 
 

Performances:  
 

The performance tab allows you to tune some performance elements in order to get a 
better frame rate. 

 
GPU Level: This first field is 
an indicator of how powerful 
your graphic hardware is. 
The level can be between 0 
and 5. Although the 
program will run on any of 
those levels, we recommend 
at least a GPU Level 2 in 
order to fully enjoy NuVJ. 
Under Level 2, some 
features might not be 
available, as the hardware 
provides no support for 
them.  
 
Rendering Quality: This 
slider is used to specify a 
quality level for various aspect of the rendering process. It expresses the tradeoff 
between image quality and rendering speed. If all the way to the right, full quality is 
preserved. If all the way on the left, quality of various aspects (preview, internal 
processing, etc…) will be degraded and frame rate will increase due to a lesser amount of 
processing. Try various setting, and remember that the resolution selected in the 
‘Display’ tab will automatically influence the performance of your system. 

 
Disable Contrast/Brightness Control: On slow performing hardware, you can disable 
the contrast/brightness controls to leave room for the main processing. 
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Advanced 
 

Auto purge after: When a 
movie is imported into NuVJ, 
it stays in memory even 
when not allocated to any 
cell. Freeing the unused 
movies is important to avoid 
unused movies to hog the 
computer’s memory. This 
setting allows you to set a 
timer to regularly purge 
unused movies. 
 
Auto purge when 
physical memory left 
reaches: This setting allows 
you to automatically purge 
the unused movie when the 
physical memory of the computer becomes low. This option is only available for PC.  
 
Use Mask and Copy Mode on Deck A: Normally, mask and copy modes defined in the 
cell parameter panel are only active when the cell is playing on Deck B. By activating this 
option, you make the parameters active on Deck A, which means that the cell running on 
deck A will first be composed with the background clip using masking & copy settings 
before being sent to the mixer. Combining this option with the fact that you can change 
the background by drag and dropping visual on the master preview gives more advanced 
mixing capabilities. 
 
Play sound in QuickTime movies: By selecting this option, the sound tracks of 
QuickTime movie won’t be ignored, allowing NuVJ to scratch both video and audio at the 
same time. 

 
 

Controller: 

 
The controller section contains option related to using the controller. 

 
Status: shows the status of the controller (offline/connected) 
Firmware: shows the firmware level of the controller (only available if the controller is 
connected) 
LCD Contrast: Allows you 
to set the LCD contrast of 
the controller. Once set, the 
contrast setting is stored 
permanently in the 
controller and will be 
recalled next time the 
controller is used. 
Scratch sensitivity: sets 
the sensitivity of the jog 
wheels in scratch mode 
Slide Sensitivity: sets the 
sensitivity of the jog wheels 
when using them without 
the scratch button pressed 
(‘pitch bend’). 
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PERFORMANCE TIPS 
 

 
 
 
 
 
 
 
 
 
 
Attaining good performance with video can be difficult because it depends on a lot of different factors.  
 
The most important factors are: 

 
• CPU speed 
• Disk speed 
• RAM access speed 
• Video hardware & video bus speed 
• Movie compression 

 
There is no easy way to give a definitive answer in terms of what is best for every computer setting. In 
NuVJ, most of the graphic processing is done in the video hardware, so the more powerful it is, the better 
performance you are going to get. The CPU is mainly used to decompress movie frames from the disk and 
send them to the video card. The faster your drives are, the faster frames will be loaded in the memory and 
the faster your CPU is, the faster it will decompress the frames. To achieve a good frame rate with a given 
hardware, you can: 
 
• Adapt the resolution of the internal computation. See (Preferences/Display) 
• Use the performance slider to find a balance between quality and performance that is adapted to your 

hardware. 
• Use source material that is adapted to your hardware. If you have a slow disk or older generation of 

hardware, try working with smaller video sources to minimize the impact of loading and 
decompressing the movie. Since all calculations are done inside the video hardware, aliasing effects 
will be minimized by the automatic filtering applied when the images are scaled to the final resolution. 

 

Movie Compression 
 

Beside movie size, their compression scheme has a huge impact both on the fluidity of the display and their 
playability. The more complex the compression scheme, the more work the processor will have to do to 
recover specific frames, resulting in sluggish performance. In addition to the compression method itself, 
there’s the issue of key frames. Most widely spread compression mechanism work using incremental 
methods, which means they construct a frame by storing the difference between a frame and the previous 
one. In order to keep the process from deriving too much from the original material, they store an original 
frame every now and then, and start again coding incremental information from that frame on. These 
original frames are called ‘key frames’. Using sparse key frames will mean that for NuVJ to access a given 
frame, it will have to find the previous key frame and process all the intermediate frame differences until it 
reaches the desired one. As you can imagine, this process is rather slow and prevents fast access to frames, 
which is very important for backward playback or scratching. That’s why compression schemes like mpeg or 
DivX are not at all suited for video performances. 
 

 
 
 
 
 
 
 

Memory usage 
 

Movies are pretty big memory eaters. Depending on their size and length they can use a lot of space very 
fast. When a file is imported in NuVJ, it is kept in memory even if it is not assigned to any cell. This is so 
that you can use the ‘visual’ browser to look for files which have already been loaded, without having to 
browse and import them again. When the memory of the computer is getting full, its performance can 
decrease so it is important to keep an eye on that factor. To release unused movies from the software, you 
have to ‘purge’ them. This can be accomplished in several ways: 

1.  By manually purging the movies using the menu ‘Edit/Purge Visuals’ 

2.  Using the auto-purge feature, which can be set in the Preferences/Advanced dialog. Auto-purge will let 
you select a time or memory threshold which, when reached, will automatically purge the unused movies 
from your computer’s memory. For more information about that feature, please refer to the Preferences 
section of this manual.  

It is very important to note that popular compressions schemes are very inefficient 
for VJ’ing. Video files using these compression schemes will behave ‘correctly’ when 
used at nominal speed (100%), but will be very sluggish if you change their playback 
speed or scratch them. This remark is valid for mpeg, divx and DV codecs, among 
others. If you use these compression formats, you will get poor performance from the 
software. 

From our experience, the best compression scheme for video performance 
is QuickTime’s Photo JPEG with a quality setting of about 80% or more. 
This will ensure smooth playback, effective scratching and decent file size. 
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